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SEM-1
CORE-1
FOUNDATION ART
Theory
1.Aesthetics of art
Six limbs of art
Form
Measurement
Expression
Beauty
Similarity

Colour composition

2.Relation between Painting & Animation
In the sense of Colour ,Tone practice Drawing, Background design. Sketch,

3.Great Artist
Painter
Leonardo da Vinci
Rembrandt
Sculptor
Michel Angelo
Animation drawing study




Movement study

Posing

Rapid sketch

Cartoon body construction

Construction of body

Construction of head

Live pose convert to cartoon character

Pencil Study

Holding, Grip, Freeing the hand

Pencil Strokes

Straight, parallel, horizontal, Curve circle, scribble drawing

Tutorial
Light & Shade

Still life study [Pencil sketch & Charcoal]
Flower Vase
Fruit
Water colour

Natural beauty
Hillside
See
Outdoor study

Perspective study
Railway station
Building construction from different view
Birds eye perspective

4.Anatomy study
Human anatomy
Animal anatomy
5. Zoo study

elephant
Horse
Tiger
lion
Rhinoceros
6.Domestic animal study
Dog
Cow
Goat

SEM-1
CORE-2
DIGITAL ART & STORY BOARDING



Theory

1.Working layers
What is a layer
Blending modes
layer styles
Working with layers

2.Selection and Layer Mask

Selecting image in a layer

layer masking

Clipping mask

Selecting different portion of image in a layer
Masking two image by layer mask

3.Tone and colour correction

Colour corrections
Hue saturation
Colour balance
Photo filter
Channel Mixer
Variation

4.Additional options for tone and colour correction

Exposure
Curves.

Levels
Brightness/contrast
Vibrance

Black and white
Invert

Posterize
Threshold
Gradient map
Shadow map
Desaturate
Match Colour
Equalize

Essential Filters

Filters
Filter gallery



Awrtistic
Blur
Brush strokes
Distort
Noise
Pixilate
Render
Sharpen
Sketch
Stylize
Texture

6. Types of Essentials
Detail about all the filters and its impact on an image.

7. Essential Blending modes
Giving brief descriptions on diff blending modes:_
Normal
Dissolve
Multiply
Screen
Overlay
Soft Light
Hard Light
Vivid Light
Liner Light
Pin Light
Color Dodge
Liner Dodge
Color Burn
Linear Burn
Darkens
Lighten
Difference
Exclusion
Hue
Saturation
Color
Luminosity

8. Essential Layer Effects And Styles:
Giving brief descriptions of diff layer styles and its controls:

Drop Shadow
Inner Shadow



Outer Glow

Inner Glow

Bevel And Emboss
Stalin

Colour

Gradient

Pattern Overlay
Stroke

9.Sharing Images :

How to create a new image

Opening and importing any image in Photoshop
Adobe Bridge and adobe mini bridge

Changing the pixel dimension of an image
Pixel

Pixel aspect ratio

10.Retouching Essentials :

HRD toning
Match colour
Replace colour
Auto tone
Auto level
Auto colour

11. StoryBoard

Pre Production

Objective of Story board
Types of Storyboard
Implication of StoryBoard

Tutorial :

Banner Design

Poster Design

Greeting Card

Photo Retouching

Application Of Photoshop Tools For Game texturing
Character Designing From Concept Art

Vehicle Designing

Additional Game Props Designing

Game Environment Designing

Storyboarding for Advertising Film



SEM-1
GE-1
GRAPHIC DESIGNING

1. Introduction

> 1.About Corel Draw

> 2. The User Interface

> 3. Creating a New Document

> 4. Opening a Existing Document
> 5.Working With Templates

> 6.Layout

> 7.lmport

> 8.Export

2. Tools

> pick tool

> Smudge Brush

> Roughen Brush

> Free Transform Tool
> crop tool

> Hand Tool

> text tool

> freehand tool

> rectangular tool

> Interactive tool

> Eyedropper tool

> outline tool

> Fill tool

> interactive Fill tool
> Selecting fill and outline color

3. Corel Draw Layout
> Insert Page

> Delete Page

> Rename Page

> Page Setup

> Page Background



4. Working with Curves
> Free Hand Tool

> Bezier Tool

> Pen Tool

> Polyline Tool

> Artistic Media Tool
» 3-Point Curve Tool

> Shape Tool

5. Working with Shape
& Object

> Drawing Rectangle
> Drawing Circle

> Drawing Polygon
> Creating Star

6. Working with Basic shape, Arrows, Flowchart Shape, Banner Shape
7. Working with Text & Line

> Formatting Text

> Formatting Paragraph

» Changing Shape of the Text

» Working With Lines

8. Interactive Tool

> Blending tool

> Contouring the Object

> Distorting Objects

> Envelope tool

> Extruding of the Object

> Drop Shadow

> Applying Transparency Effect

9. Working with Bitmaps

> Converting Objects to Bitmap
> 3D Effect

> Art Effect

> Blur Effect

> Color Transformation Effect
> Contour Effect



> Creative Effect
> Distort Effect
> Noise Effect

10. Arranging Object

» Transforming Object

> Align & Distribute Object

> Ordering Object

> Locking & Unlocking Object
> Shaping Object

11. Designing Visiting Cards,
Boucher, Poster, Logo
& Many More.....

Adobe Illustrator

Session 1

6.6.11

Why Adobe lllustrator?

any project (even this syllabus was created in lllustrator).

Show lllustrator samples.

What are Vector Graphics?

Selection Tools:

There are three main selection tools:

Selection Tool (quick key: V) selects entire groups

Direct Selection Tool (quick key: A) selects individual object or individual anchor point
Group Selection Tool (located behind the direct selection tool) selects groups within
groups

Working with the selection tools:

Selection tool: click on OR click and drag to select object OR double click on an object
in a group to isolate

Direct selection tool: click on point or click in center of object

Group selection tool: click object once to select, click again to select the group it is in,
click again etc.

*groups within groups are called nesting groups

FHA: selects all

Holding down shift while clicking on an object will select multiple objects.

Holding down shift while clicking on objects already selected, will deselect the object.
Magic Wand

The magic wand selects objects based on their common attributes. You can tell the
magic wand how

similar you want things to be by setting the tolerance. The lower the tolerance, the more
similar the objects

will be. The higher the tolerance the similarities will be much broader.

Drawing with Path Primitives:



Rectangle Tool (quick key: M)

Ellipse Too (quick key: L)

Review all other primitive paths, apply stroke and _|II.

Work with align dialogue box (Window: Align)

Work with path_nder dialog box (Window: Path_nder)

Work with grid and snap to grid (View: Snap to Grid)

Drawing with the Pen Tool:

Anchor points are connected by paths. We do not draw paths, they are created between
the anchor points

to connect them.

Drawing straight paths with the Pen tool: (quick key: P)

Drawing curved paths with the Pen tool

Drawing free form paths with the Pencil tool: (quick key: N)

Smoothing and erasing paths

Editing anchor points

Joining and averaging paths - Object: Path: Join (quick key:d8J) - Object: Path: Average
(quick key:~<=3£J)

Simplifying paths

Using O_set Path

Cleaning up errant paths

Session 2

6.13.11

Drawing in lllustrator

Working with outside images

Applying _Il and stroke

Using the eyedropper

Working with pantone chips

Working with the appearance dialogue box

Compound paths and building shapes, drawing modes

Session 3

6.20.11

Type & Type Tools

There are two types of type in Illustrator; Point Text Objects and Area Type Objects,
there is also something

called Type on a Path but it is very similar to a Point Text Object.

Point Text Object (quick key: T): creates continuous text, in other words it has no line
breaks

Area Type Objects (quick key: T + drag): creates a text box which makes line breaks
Character Settings

Paragraph Settings

Text Threads

Setting text on open paths

Setting text on closed paths

Text to paths

In Class: build a logo

Session 4



6.27.11

Appearance & Fill

Through the Appearance Panel you are able to target individual attributes.

Fill and Stroke

Making more than one stroke

Changing stroke color and weight through the appearance panel

Changing stacking order through the appearance panel

Color dialogue box (three locations)

Gradients

Pattern _llIs

Applying pattern _Il to a stroke

In Class: build a pattern _l

Session 5

7.11.11

Grouping Objects

Grouping objects lets you quickly move and edit individual object as one object.

To select multiple objects use (~< click)

To group use (38G)

To isolate a group within a group (called a nested group) double click. To get back to
regular mode, double

click on a an empty section of the art board, hit the escape key or use the “crumb” trail
at the top of your

document.

Applying Attributes to a Group

When you group objects, Illustrator treats those graphics as if you have put them “into a
container”. You are

able to then add e_ects and attributes to the “container” or group of objects.

Adding a drop shadow e_ect to a group

Using path _nder e_ects in the appearance panel to e_ect a group

Layers

You may be familiar with layers and how Photoshop uses them. In illustrator, layers are
used in a much

di_erent ways, they let you view every single object in your document as a separate
piece of art. Creating

layers can be very important when creating a _le you are planning to export it to a
di_erent program. For

for example you are now able to export lllustrator layers into Flash as frames.

Layers can show you the objects within each layer.

You are able to create layers as you go.

Read only layers

Art Boards

An art board is what lllustrator refers to as a page. lllustrator will print whatever is visible
on a page.

Artboards can be any size or orientation and can all live in one document together.
Creating artboards through a new document.

Modifying artboards through the tool bar.



Modifying artboards through the artboards dialogue box.
Using smart guides to easily align artboards.
Transforming and Positioning Art

Moving and copying artwork

Scaling or resizing artwork

Rotating artwork

Re_ecting and skewing artwork

Using the Free Transform tool

Repeating transformations

Performing individual transforms across multiple objects
Aligning objects and groups precisely

Distributing objects and spaces between objects
Working with images

Placing pixel-based content into Illustrator

placing a link (_le: place, choose link option)

Imbedding an image (_le: place, choose embed option)
*you can only apply transformations to an image in Illustrator but can NOT change
pixels

Managing images with the Links panel

relink

go to link

update link

original

Converting pixels to paths with Live Trace

blur to get a cleaner trace

low rez _les work best

Making Live Trace adjustments

live trace default, threshold

tracing options dialogue box

Controlling colors in Live Trace

modifying color by outputting color to swatches

working with pre established swatches

Using Photoshop and Live Trace together

live trace a _le, then modify in Photoshop

Session 6

7.18.11

Working E_ciently with Symbols

Symbols can de_ne anything but linked images. A symbol lives in the symbol dialogue
box and therefore

does not increase the size of your _le-because you are not copying and pasting the
vectors over

and over again, the vector image lives in the symbol box and you only use a “reference”
or “instance” on

your artboard

Managing repeating artwork with symbols

Modifying and replacing symbol instances



Using the Symbol Sprayer tool

area of in_uence

[ ] increase or decrease the size of sprayer

click and drag

Working with Masks

Cropping photographs

Clipping artwork with masks

De_ning masks with soft edges

Printing, Saving, and Exporting

Printing your lllustrator document

Saving your Illustrator document

Creating PDF _les for clients and printers
PDF/x-1a:2001 best option for printers, _attens transparencies at a high rez & imbeds
fonts

Smallest size _le: great for sending to client, especially ones who are not computer
savvy

Exporting Illustrator _les for use in Microsoft O_ce

_le: save for Microsoft O_ce

Exporting Illustrator _les for use in Photoshop

_le: export: format: Photoshop (psd)

Exporting artwork for use on the web

make one artboard active

_le: save for web and devices

Exporting high-resolution raster _les

_le: export: ti_

In Class: create a brochure with masks and images and export for the printer and for
the client

Session 7

7.25.11

Choosing lllustrator for Web and Interactive Design
Artwork can be repurposed for any screen

Integrates easily with other programs

Using the Web document pro_le

_le: new: web document pro_le

review advanced settings (preview mode: turn on pixel)
Setting up an Entire Web Site

use artboards and symbols to easily make updates
Setting up mobile content with Adobe Device Center
_le: new: device central

in create work space, content type and program type
browse, adobe certi_ed (left hand side)

drag pro_le into test devices

BITMAP to see what type of _les are compatible

create button: now the artboard is set up for your speci_c device and you know what _le
type

it supports so you know what to export your graphics as



Understanding Web-Safe Colors

always RGB

dithering tries to mix colors to get the color that isn’t web safe (usually looks bad)
window: swatch library: web

because handsets etc are quickly updating viewing technology, web safe colors are
quickly

becoming obsolete

Using Recolor Art to convert art to web-safe colors

window: color panel to check if web-safe

select art, color wheel at top: recolor artwork

button: limits the color group to colors in a swatch library

pop up menu: web:

Using the Save for Web and Devices

_le: save for web and devices (review)v

Session 8

Personal Project

Adobe In-Design
Adobe Page Maker

SEM-II
CORE-3
TRADITIONAL ANIMATION

THEORY

Classical Animation

Technical concept

Using instrument

Difference between classical & Digital animation film
Steps of animation

Theme

Premise

Script

Pre-Production

Storyboard

Layout

Sequence planning
Scene planning
Shot planning
Animatics
Character



Design
Model sheet
Posing
Back ground
Layout
Design

Production
Animation

Key pose drawing
In between drawing
Cleanup

Post Production
Compositing
Editing

TUTORIAL

Story board

Back ground designing
Introduce with light box

Time & Spacing concept

Coin Assignment With Slow in
Coin Assignment With Slow out
Coin Assignment on Curve path
Pencil test

2D Animation as a powerful technic
i. Bouncing Ball

Weight & Balance

Iron ball

Ping pong ball

Difference between animation process, techniques & styles
Pose to pose animation
Straight ahead animation

Using stick drawings

Follow through With Iron Wire
Follow through With Rubber Stick
Follow through With Feather
Pendulum [ Hinged & Classical]



SEM-II
CORE-4
DIGITAL ANIMATION 2D

2D Digital Character animation

Animation

Theme Premise

Script

Pre- Production

Story board

Layout

Sequence planning

Scene planning

Shot planning

Animatics

Character

Character Design with pencil
Character Model sheet with Pencil
Posing

Digital Character Design
Digital Character Model sheet
Back ground

Layout

Pencil Design

Digital Designing & color

Props Designing
Symbol Create

Production
Character Rigging
Character Animation
Post - Production
Compositing
Editing
TUTORIAL

Tracing and colour fill ten (10) different 2 dimensional & 3 dimensional props



Tracing and colour fill Animation background
Character model sheet tracing and colour fill
Character Rigging

Animation-

Walk cycle[ male & Female]
Run Cycle

Jump

Weight lifting

Push the box

Stair Case

Conversation

Four leg Animation

Wing Animation

SEM-I11
GE-2
WEB DESIGNING
Group - A
Module 1 1.0 Web Design Principles
1.1 Basic principles involved in developing a web site
1.2 Planning process
1.3 Five Golden rules of web designing
1.4 Designing navigation bar
1.5 Page design
1.6 Home Page Layout
1.7 Design Concept.
3L+1T
Module 2 2.0 Basics in Web Design
2.1 Brief History of Internet
2.2 What is World Wide Web
2.3 Why create a web site
2.4 Web Standards
2.5 Audience requirement.
9L+3T
Group-B
Module 3 3.0 Introduction to HTML
3.1 What is HTML
3.2 HTML Documents
3.3 Basic structure of an HTML document
3.4 Creating an HTML document
3.5 Mark up Tags
3.6 Heading-Paragraphs
3.7 Line Breaks



3.8 HTML Tags.

oL+3T

Module 4 4.0 Elements of HTML

4.1 Introduction to elements of HTML

4.2 Working with Text

4.3 Working with Lists, Tables and Frames

4.4 Working with Hyperlinks, Images and Multimedia
4.5 Working with Forms and controls.

6L+2T

Group-C

Module 5 5.0 Introduction to Cascading Style Sheets

5.1 Concept of CSS

5.2 Creating Style Sheet

5.3 CSS Properties

5.4 CSS Styling(Background, Text Format, Controlling Fonts)
5.5 Working with block elements and objects

5.6 Working with Lists and Tables

5.7 CSS Id and Class

5.8 Box Model(Introduction, Border properties, Padding
Properties, Margin properties)

5.9 CSS Advanced(Grouping, Dimension, Display,
Positioning, Floating, Align,Pseudo class, Navigation Bar,
Image Sprites, Attribute sector)

5.10 CSS Color

5.11 Creating page Layout and Site Designs.

6L+2T

TUTORIAL

Module 6 6.0 Introduction to Web Publishing or Hosting
6.1 Creating the Web Site

6.2 Saving the site

6.3 Working on the web site

6.4 Creating web site structure

6.5 Creating Titles for web pages

6.6 Themes-Publishing web sites.

SEM-111
CORE-5
ANIMATION SET DESIGNING 3DS

Theory

Introduction to 3D CGI 2._Getting Started with 3ds Max

3. Viewing and Navigating 3D Space 4. Selecting Objects



5. Object Properties 6. Creating Geometry

7. Moving, Rotating, and Scaling Objects 8. Modifiers

9. Surface Modeling 10 Level Designing For Game
TUTORIAL

Mesh Modeling Tools

Modeling a Gun

Modeling a Floor-Buffer

Modeling a Truck (Low-Poly)
Modeling a Air force Helicopter
Modeling a Castle and Environment

SEM-11I
CORE-6
CHARACTER DESIGNING 3DS

Theory

High & Low Poly Characters

Before you start: The Concept

An Exclusive Knowledge of Anatomy
Collecting References

Setting up the Image Planes

Starting to build the character

Getting the basic proportions right
Cutting in more detail

The Hi resolution mesh: Adding More Detail
Shell Modifier

Subdivide your model with turbo-smooth

TUTORIAL
Modeling a warrior/ Soldier

SEM-I1I
CORE-7
CG TEXTURING 3DS
Theory

Designing Materials



Material Editor
Material/Map Browser
Material Explorer
Types of Materials
Maps and Shaders

Material, Mapping, and Vertex Color Utilities

Unwrap UVW

TUTORIAL
Texture the Low-Poly Truck
Texture Warrior/Soldier

SEM-111

SEC-1

DIGITAL SCULPTING

THEORY

INTRODUCTION TO Z- BRUSH
APPLICATION

TOOLS

PRESETS

TEXTURE

SCULPTING

DIFFERENT BRUSH STROKES
Anatomy Study

TUTORIAL
Monster creation

SEM-111

GE-3

MEDIA MANAGEMENT

Channels of New Media,
Assimilation to Distribution

SR. TOPICS SUBTOPICS AND LEARNING POINTS
NO.

Introduction to New Media, Internet: Mother of New Media, Analog Vs
UNIT | Traditional Media VS New Media, Digital, Journey from Traditional Media to

New Media, Factors Influencing the Advent
of New Media, Website, Blogs, E-Mail,
Mobile Phone, Tablet PCs, The Channels and




Players , The Tools and The Software, The
Challenges with Channels of Distribution

C
—

The New Media Content Providers,
Introduction to Social Media, From
4Ps to 4Cs, User Focused Content,
User Centered Design and User
Generated Content, Comparison
between Traditional media and New
Media

Characteristic of Social Media, Usage of
Social Media in Various Disciplines, Social
Media: Strategy Planning, Understanding the
current trends, Digitization of Media and
Power of Mobility/Internet,
Disintermediation of Content Distribution,
Preparing your organization for new age of
IME, Graphic and Static Text, Simulation:
Ultimate Content Immersion, Features of
effective website, Print and broadcast news
over the internet, online vs traditional
shopping, www. An introduction

C
—

Introduction to E- Commerce,
Various forms of Transactions and
Communications, The Player
Involved and the Process, New
Media Marketing, Elements of E-
Marketing

Advantages of E- Business, E- Commerce,
Anatomy of E-Commerce, Functions of E-
Commerce, Advantages and Challenges,
Understanding the online Shopping
Experience, User Engagement,
Measurements and Analytics for New Media,
SEO and SEM, Meta Tags, Tags,
Folksonomy

Cc
zZ
—

<

Promotion And Communication,
Social Media as a Marketing tool,
Behavioral and Contextual
Promotion, Contextual Advertising,
Customer Service to Customer
Service Relationship, Basic of Digital
Graphics, Social Media- A Boon or
Bane

Modes of Social Media Marketing, Growth,
Benefits, Understanding the relevance, The
Pervasiveness, Role, Reasons, Barriers to
implementation at Companies, Social Media
Marketing in India-An Overview, Marketing
Strategies, Customer Service Strategies,
Boon Or Bane

SEM-IV
CORE-8
ADVANCED BG DESIGNING
Theory

Introduction to Autodesk Maya 2011
Getting Started with Autodesk Maya 2011 with user interface



3. Viewing and Navigating 3D Space 4. Selecting Objects, paint selection tool, soft
modification tool

5. Object Properties 6. Creating Geometry and Component modes

7. Moving, Rotating, and Scaling Objects universal manipulator 8. Deformers
9. Surface Modeling 10 Level Designing For Game 11. Shelf Editor

TUTORIAL
SPACESHIP Designing

SEM-IV
CORE-9
ADVANCED CHARACTER DESIGNING

High Poly Characters.

Before you start: The Concept

An Exclusive Knowledge of Anatomy

Collecting References images .

Importing the Image Planes to the Ul and adjust them in respective coordinates axis .
Starting to build the character with Create polygon tools

Getting the basic proportions right

Cutting in more detail with Split polygon tools Page-18

The Hi resolution mesh: Adding More Detail

Subdivide your model with —smooth and average vertices.

TUTORIAL

Modeling a High Poly Monster.

Modeling a Quadraped/multileg Creature
Modeling a female Character without face
Designing the cloth for the female

SEM-IV
CORE-10
ADVANCED TEXTURING IN MAYA
Theory

Designing Materials from UV texture editor .
UV texture editor window



Using Hypershade to assign and project different types of materials

Breaking Material in Hypershade by using input and output connections

Types of Materials and assigning 2D and 3D texture to a selective material

Assigning basic Utilities to materials.

Create different UVs like planer maps, cylindrical maps.

Cut UVs, Sew UVs, Move and Sew UVs

Unfold UVs, Relax UVs, UV Lattice tools , UV Smudge Tool ,Toggle Texture border , UV
snapshorts

TUTORIAL

Texture the Vehicle model in CDM
Texture the Monster model in CDM

SEM-IV
SEC-I1
DIGITAL PAINTING
INTRODUCTION TO DIGITAL PAINTING
BODY PAINT 3D
DIFFERENT TEXTURING TECHNIQUE
INTRODUCTION TO UV LAYOUT

TUTORIAL
Applying paint textures to any character
SEM-IV
GE-4
ARCHITECTURAL VISUALIZATON
THEORY
AUTOCAD:

Introduction and project overview, Main components and interface,

Drawing tools, Drawing guides, options, and modifiers, working with layers, drawing the floor
plan, 3D environment introduction, Beginning the 3D model, Finishing the 3D model, 3D view
styles

REVIT:

Introduction and project overview, Setting levels, Creating floors, Creating walls, Placing
components into models and plans, Creating stairs by using the Stair By Component, Creating
stairs by using the Stair By Sketch tool, Creating a guardrail for floor openings, Creating a basic
roof system

3DSTUDIO MAX DESIGN:



Introduction 3D Max, Creating Basic Primitives, Selection Types,

Customization, Modifiers, Shapes, Compound Objects, Architectural Objects, Lights' Cameras,
Array Tools, Materials Basics, Compound Materials, Particle Systems, Forces, Editing Mesh
Obijects, Importing Objects, Animation Basics, Architecture and Virtual Reality.

V-RAY AND GREEBLE:

Introduction to V-RAY, Application of V-RAY in Computer Graphics (CGl), Glass and Liquid,
How to use HDR images in V-Ray, Material settings, Render settings, Standard studio lighting,
Greeble city creation

TUTORIAL

1. Introduction to project overview, 2.site texturing, 3.Creating site reflection texture, 4.
Importing images to AutoCAD, 5.Drafting contours and building in AutoCAD, 6.Importing
AutoCAD files to 3DS Max, 7.Terrain creation, 8.Terrain mesh division and site texture,
9.Greeble city creation, 10.Extracting textures for the facade of the city, 11.Texturing the city
model, 12.Prepairing architectural AutoCAD plans, 13.Iporting AutoCAD plans to 3DS Max,
14.Updating linked plans, 15.Modeling organic outlines using splines, 16.Extruding splines,
17.Modeling the tower facades, 18 Modeling slabs and balustrades, 19. Creating more slabs,
balustrades, and columns, 20. Modeling columns and lift cores, 21. Organic modeling of the
stadium support, 22. Modeling the stadium seating, 23.Editing the seating model, 24.Editing the
tower and seating connection, 25.0rganic modeling of the stadium shell, 26. Editing the top roof
slab, 27. Modifying floor slabs and adding stadium details, 28.Editing ground terrain for grass
and plants, 29.Creating proxy and billboard plants, 30. Scattering plants and importing proxies
into the model, 31.Modeling pavilions using nurms, 32. Texturing the glass facade, 33.Texturing
the building interiors, 34.Texturing the balustrades, 35. Summing up the texturing, 36.Render
settings for draft views, 37.Getting the final image, 38.Photoshop workflow and conclusion

SEM-V
CORE-11
CG LIGHTING &RENDERING

THEORY

Using Lights Ambient light, Direct Light, Point light , Spot Light , Area light , Volume light .
Retrace shadow and depth map shadow.

Different types of Render Settings Mental Ray , and Vary render , Maya Vector render .
Common Lighting Rollouts and Dialogs

Shadow Types and Shadow Controls

Create Physical sun and Image based lightning .

V-Ray Light

Light Linking Editor . Light centric and Object Centric

Final Gather , Global illumination , Caustic effects .

Create Different Pass Render from Render Layer .



Standard, Mental Ray & V-ray Rendering System

TUTORIAL

Interior Lighting any Game Environment
Daylight of any Game Environment

SEM-V
CORE-12

RIGGING FOR ANIMATION

Rigging In Maya

1. Joint Tool 7. Disconnect Joint

2. IK handle Tool 8. Connect Joint

3. Ik Spline handle Tool 9.Mirror Joint

4. Insert Joint Tool 10. Orient Joint
5.Reroot Skeleton 11. Set Preferred Angle

6. Remove Joint

Skinning

Bind Skin

Detach Skin
Bind Pose

Edit Smooth Skin

Constrain

Point

Aim

Orient

Scale

Parent

Pole vector

Set Rest Position

MOTION BUIDER
THE SET UP MACHINE

TUTORIAL
Rigging & Skinning a human in Maya

SEM-V



DSE-1

ENTREPRENEURSHIP DEVELOPMENT
Unit |
Meaning, Definition and concept of Enterprise, Entrepreneurship and Entrepreneurship
Development,
Evolution of Entrepreneurship, Theories of Entrepreneurship. Characteristics and Skills of
Entrepreneurship,
Concepts of Intrapreneurship, Entrepreneur v/s Intrapreneur, Entrepreneur Vs. Entrepreneurship,
Entrepreneur
Vs. Manager, Role of Entrepreneurship in Economic Development, Factors affecting
Entrepreneurship,
Problems of Entrepreneurship
Unit 11
Meaning and concept of Entrepreneurial Competency, Developing Entrepreneurial
Competencies,
Entrepreneurial Culture, Entrepreneurial Mobility, Factors affecting Entrepreneurial mobility,
Types of
Entrepreneurial mobility. Entrepreneurial Motivation: Meaning and concept of Motivation,
Motivation
theories, Entrepreneurship Development Program: Needs and Objectives of EDPs, Phases of
EDPs, Evaluation
of EDPs
Unit 111
Role of Government in promoting Entrepreneurship, MSME policy in India, Agencies for Policy
Formulation
and Implementation: District Industries Centers (DIC), Small Industries Service Institute (SISI),
Entrepreneurship Development Institute of India (EDII), National Institute of Entrepreneurship
& Small
Business Development (NIESBUD), National Entrepreneurship Development Board (NEDB),
Financial
Support System: Forms of Financial support, Long term and Short term financial support,
Sources of Financial
support, Development Financial Institutions, Investment Institutions
Unit IV
Women Entrepreneurship: Meaning, Characteristic features, Problems of Women
Entrepreneurship in India,
Developing Women Entrepreneurship in India, Concept of Social Enterprise and Social
Entrepreneurship,
Social Entrepreneurs, Sustainability Issues in Social Entrepreneurship, Rural Entrepreneurship,
Family
Business Entrepreneurship, Concepts of Entrepreneurship Failure, Issues of Entrepreneurial
failure, Fading of
Entrepreneurial success among once leading corporate groups, Entrepreneurial resurgence,
Reasons of
Entrepreneurial Failure, Essentials to Avoid Unsuccessful Entrepreneurship.
Unit vV



Forms of Business Ownership, Issues in selecting forms of ownership, Environmental Analysis,
Identifying

problems and opportunities, Defining Business ldea, Planning Business Process, Project
Management:

Concept, Features, Classification of projects, Issues in Project Management, Project
Identification, Project

Formulation, Project Design and Network Analysis, Project Evaluation, Project Appraisal,
Project Report

Preparation, Specimen of a Project Report

SEM-V
DSE-2
AUDIO VIDEO EDITING

Sonic Foundry Sound Forge
Introduction

Digitizing sound

Technical terms

Sound Editing concepts

Intro to Sound Forge7

Ul

Workspace

Working with sound forg7
Working with projects
Working with files
Recording

Audio editing

Select and positioning cursor
Basic editing

Using markers and regions
Editing with playlist

Effects
Applying effects
Amplification modulation
Chorus

Simple delay
Reverb

Wave hammer
Distortion
Dynamics
Envelop

Flange

Gaper



Noise gate
Pitch

Adobe Premiere Pro

Obijectives

Get started with Premiere Pro

Assemble a project

Edit a sequence

Enhance a sequence with transitions, effects, titles and composites
Work with audio

Export a video

Getting Started with Adobe Premiere Pro
Topic 1A: Explore the Premiere Pro Interface
Topic 1B: Customize the Workspace
Topic 1C: Create a Project

Section 2: Assembling a Project

Topic 2A: Import Videos

Topic 2B: Organize Media Files

Topic 2C: Add Clips to a Sequence
Section 3: Editing a Sequence

Topic 3A: Edit Footage

Topic 3B: Edit Clips

Section 4: Enhancing a Sequence

Topic 4A: Apply Effects

Topic 4B: Add Transitions

Topic 4C: Add a Title

Topic 4D: Create a Composite

Section 5: Working with Audio

Topic 5A: Add Audio

Topic 5B: Apply Audio Effects

Section 6: Exporting Video
Topic 6A: Export a Movie File
Topic 6B: Export Clip Notes
TUTORIAL

Mixing

Song Editing

Appling Sound Effects

Non Linear Video Editing

Reference Books:
Hollywood 2D Digital Animation by Corsaro Parrott
Character Animation 2D Skills for better 3D by Steve Roberts



SEM-VI
CORE-13
3D ANIMATION
Principles of Animation

Time 15.Line of action

Space 16.Path of action

Slow out 17.Arc

Slow in 18.Volum
Stretch 19.Shape

Squash 20.Weight
Follow through 21. Balance

Overlapping action 22.Rythem

Secondary action 23.Tension & Force
Anticipation 24. Direction
Cousin 25.Detailing
Settle 26.Simplification
Stagger 27.8 Path
Exaggeration 28. Plans

Graph Editor
Spline

Liniar

Clamp

Steped

Flat

Platean

Introduction to Character Studio
Biped User Interface

Figure and Keyframe Modes
Animating the Biped
Biped Properties

Understanding Physique

Biped and Physique

Envelopes and Weighted Vertices

Deformable and Rigid Envelopes

The Number of Links That Can Affect a Vertex
Physique Workflow

Understanding Track Editing



Understanding Motion Flow & Non Linear Animation
Camera Animation
Animation Constrain

TUTORIAL

Bouncing Ball[Stretch & Squash]

Iron ball [ Mass Animation]

Walk through[Path animation/Camera animation]

Pendulum with feather[8 path ,Follow through, Secondary action Time & Spacing]
Tail with Bouncing ball[Overlapping]

SEM-VI
CORE-14
CHARACTER ANIMATION
Maya Animation Tools & Technique
Time line
Play blast
Onion Skin

Graph Editor
Spline

Liniar

Clamp

Steped

Flat

Platean

Character Animation
Walk Cycle
Run Cycle
Jump
Weight lifting
Push the box
Stair Case
Conversation
. Four leg Animation

TUTORIAL
ANIMATION TVC CREATION

SEM-VI
DSE-3
FILM COMPOSITING

THEORY



01 Introduction

A_00_intro, 01_.B_other_applications

02 Creating a Simple Project

A_workflow_overview. B_setting_up. C_shapes_presets. D_animated_text.

03 Project and Importing Essentials

A_glance_interface. B_saving_interface. C_projects. D_importing. E_transparency.
F_sequences.

04 Using Compositions and Layers

A_what_composition, B_adding_imported, C_layers_work, D_managing_multiple,
E_blending_layers,

F_aligning,

05 Creating Animation

A_animating_properties, B_wizard_position, C_anchor_point, D_rotating, E_adjusting_moving,
F.duplicating_copying,

07 The Power of Effects

A_applying_effects, B_glow, C_infinite_textures, D_blur_effects, E_lens_flares, F_lightning.
08 Color-Correcting Footage

A_brightening, B_changing_colors, C_colorizing.

09 Creating and Animating Text

A_creating_text, B_formatting, C_text_presets, D_text _manually, E_text 3D, F_layer_styles.
11 Creating Animated Digital Drawings

A_creating_shapes, B_modifying_shape, C_combining, D_multiple_shapes, E_shape_variations.
12 Motion Paths

A _spatial_interpolation, B_motion_paths, C_orienting,

14 Concealing with Masks and Keying

A_masking_masks, B_keying.

15 Compositing

A_what_compositing, B_removing_green.

16 Stabilizing and Tracking Motion

A _stabilizing, B_tracking,

17 Precomposing and Nesting Compositions

A_when_precompose, B_composition_layers.

18 Exporting to Video and Media

A_high_quality, B_compressed,

TUTORIAL

1. Create a simple project by the help of shapes presets, animated text, and animating star, adding
effects and then precompose them.

2. Create a TV banner add with the help of adobe Photoshop and after effect.

3. Merge multiple videos and colour corrects them and shows all of them with camera animation
and may add depth of field if needed.



4. Make a composition by masking and keying or rotoscope ,track any portion and may add some
text or effects and color correct all of it by adding adjustment layers and give a final output .

SEM-VI
DSE-4
VISUAL EFFECTS
COMBUSTION
Preferences, Ul, and Key Terms
Workflow Basics, Footage, and Viewports
Paint and Text Operators
Compositing in 2D &3D
The Schematic View
Selection & Masks
Working with Color
Keying
The Tracker
Animation & Timeline
A/V Editing
Stabilizing and Tracking Motion
Integrated Particle System
Rendering & Output

MAYA

PARTICLE

FLUID

RIGID & SOFT BODIES
EFFECTS

SOLVER

CLOTH

HAIR

FUR

TUTORIAL
e Creating the Old Movie look with Combustion - Dirt and Scratches.
« Create a final composition with a help of multiple footage and add some particle effects

on them.
e Add character FX animation

Suggested Readings/Reference Course Material (Electronic & Hard Copy)



Year —I

1.

s W

Year-2

uhWwN

o

8.

9.
10.

Year-3
1.

2
3
4
5.
6
7

Acting for Animators by Ed Hooks

From Script to Screen by Sharmus Culhane

40 digital photo retouching techniques- Zack Lee
Digital Tutors Reference

Hollywood 2D Digital Animation by Corsaro Parrott

Character Animation 2D Skills for better 3D by Steve Roberts

3DS Max Bible -Willy India

3D Game Texture by Luke Ahearn

Mastering Autodesk Maya-Willy India

3D Creature Workshop by Fleming & Schrand
Digital Tutors Reference

The Aubin Academy Master Series: Revit Architecture 2011- Aubin, Paul F. (1« Ed. Ed. Clifton
Park, NY: Cengage Learning,2011. Print)

Introduction to Autodesk Revit Revit Architecture 201- Davis, Pat, and Patrik Davis (1« ed.
Hoboken, N.J: Wiley Pub., 2010 Print)

Maestering Autodesk Revit Architecture 2011: Autodesk official Training Guide-Krygiel, Eddy,
PhilRead, and James Vandezande (Indianapolis, Ind):Wiley, 2010 Print)
AUTOCAD for Engineers and Designers BY Prof.Sham Tickoo

Creating a Photorealistic Bedroom in 3ds Max- by Amr Abdeem (Video Tutorial)

3D Game Animation by Murdock

. The Modeling And Animation handbook by Autodesk

3DS Max Animation with Biped by Bousquet & McCarthy

. After Effects for Flash Flash For After Effects by Harrington& Geduld

The Focal Easy Guide to Combustion by Gary M. Davis
Digital Tutor References
Couger, C- Creativity and Innovation (IPP, 1999)

Panel of Examiner for Session-2015-16

Z
o

Name Organization

Mr. Somenath Mukherjee | BIT

Mr. Pronoy Mukherjee BIT

Mr. Rakesh Bernwal BIT

Mr. Saket Kumar ICAT

Mrs. Swastika Mukherjee | St. Xavier’s College

Mr. Naraya Saha Amity University

Mr. Chayan Bhadury St. Xavier’s College

Mr. Samir Dutta Architect
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Mr. Chandan Kumar Film Industry Professional




10.

Mr. Rakesh Raja

St. Xavier’s College Ranchi

11.

Mr. Sanjoy Chakraborty

Mentor- Arena Animation




